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Software License Agreement

We will provide "SG-Imaging" when the client agrees to the following license agreement (hereinafter referred to
as "this Agreement"). Before using this software, please be sure to read the following agreements carefully.

When the client uses some or all of the functions of the software (hereinafter referred to as "this Software")
"SG-Imaging", it shall be deemed that the client has agreed to all the contents specified in this Agreement and this
Agreement comes into effect.

I. LicenseGrants

On the premise that the client complies with all the terms and provisions of this Agreement, Shenzhen
SinceVision Technology Co., Ltd. (hereinafter referred to as "this Company") hereby grants the client a
non-professional and non-transferable license to install this Software on all computers of their companies and use
SinceVision's products.

II. Restrictions

The clients shall not be allowed to perform the following operations or modifications on this Software.
a. Except for installing updated versions or new features provided by SinceVision, the clients shall not be allowed to
modify this Software or add any new features to this Software.

b. The clients shall not be allowed to perform reverse engineering, reverse compilation, or reverse assembly on this
Software.

c. Unless explicitly stated by SinceVision, the clients shall not re-sell, transfer, lease, or re-distribute
this Software to any third party.

III. Intellectual Property

All intellectual property rights (such as copyrights) related to this Software and its manual belong to this Company.

IV. Exemption

This Company shall not be liable for any damages suffered by clients or third parties as a result of using this Software!

V. Support

This Company shall provide technical support based on this Agreement in response to questions from the clients
regarding this Software. However, this Company does not guarantee that the technical support services provided
by this company will enable the clients to achieve their expectations.

VI. Termination of thisAgreement

a. When the clients abandon this Software and its copies to stop using this Software, this Agreement will
automatically terminate.

b. When the clients violate any provision of this Agreement, this Company shall unilaterally terminate this
Agreement. At the same time, the clients should immediately dispose of this Software and its copies, or
return them to this Company.

c. When the clients violate this Agreement and cause any loss to this Company, the clients shall compensate
this Company for the relevant losses.

VII. Applicable Laws

ThisAgreement is subject to the laws of the People's Republic of China.
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Introduction

Please be sure to read this User Manual before using the software.
After reading the manual, keep it safe for your future reference.

This Software User Manual of SG Series laser products provides clients with operating instructions for the settings
of SG series point laser "SG-Imaging".

The contents of this Manual have been prepared with the aim of accuracy. But if you find any unclear,
incorrect, or ambiguous contents, please contact our Sales Department. If there are missing pages or binding
errors, we will provide replacement services.

Contact

Shenzhen SinceVision Technology Co., Ltd.

Headquarters: 5th Floor, Building 2, Chongwen Industrial Park, Nanshan
Zhiyuan, Nanshan District, Shenzhen

Dongguan Office: Room 406, Building F4, Tian'an Digital City,
NanchengDistrict, Dongguan City, Guangdong Province

East China Office: Room 1305, Building 7, Xiangyu Liang'an Trade Center
No.1588, Chuangye Road, Kunshan, Jiangsu Province

North China Office: Unit 922, Building 4, Times Fortune World, Courtyard 1,
Hangfeng Road, Fengtai District, Beijing

Southwest China Office: Room 604, Block B, Yingchuang Interational Building,
No. 66, Chuangzhi South 1st Road, Pidu District, Chengdu

Website: www.cnsszn.com Tel: 0755-29655425 400-966-0626

SinceVision's
Official WeChat Account

http://www.cnsszn.com
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Thank you for choosing SinceVision's products related to machine vision.
To repay our clients, we will provide top-notch machine vision products, comprehensive after-sales service,

and efficient technical support to help you establish your own machine vision system.

More Information About SinceVision
Please visit our website http://www.cnsszn.com for more information about us and our products, including

company profile, products, technical support, new product launches, etc.
You can also inquire about more information about this Company and products by telephone

0755-29655424.

Technical Support and After-sales Service
You can reach our technical support and after-sales service through the following channels:
E-Mail: support@cnsszn.com
Tel: 0755-29655424
Adress: 5th Floor, Building 2, Chongwen Industrial Park, Nanshan Zhiyuan, Nanshan District, Shenzhen
Postal code: 518063

The Purpose of the User Manual
By reading this manual, users can become familiar with the basic operations of the SG-Imaging software for

sensing products of machine vision and be able to perform measurement settings in actual engineering projects.

Users of the Manual
This user manual is suitable for engineering personnel who have a certain understanding of software

debugging operations.

The Main Contents of the User Manual
This manual consists of five sections. It describes in detail the installation, startup, basic operations,

parameter settings of SG-Imaging software.

Relevant Documents
For the hardware installation of the SG series point laser, please refer to the "SG Series Laser Displacement

Sensor - Hardware User Manual" that comes with this product.

http://www.cnsszn.com
mailto:support@cnsszn.com
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1 Preparation Before Operation

1.1 Software Installation

This section describes the steps to install SG-Imaging on a PC.

Notes:
 This step describes the installation process on Windows 7 operation system.
 Before starting the installation, please close other running applications.
 When installing on a Windows system, you must log in with administrator privileges.

1. Start Windows operation system and double-click the SG-Imaging installation program.
The installation wizard interface is displaying.

2. Follow the instructions on the screen for operation.

3. When the "Installation Wizard is Completing" appears, click "Finish".
Now, the installation of SG-Imaging software is completed.

 By default, SG-Imaging will be installed in C:\Program Files (x86)\SG-Imaging.

Uninstalling

This section describes the steps to uninstall SG-Imaging from a PC.

Notes:
 This step describes the uninstallation process on Windows 7 32-bit operation system.
 Before starting the uninstallation, please close other running applications.
 When uninstalling on a Windows system, you must log in with administrator privileges.

1. Double click on "Programs and Features" on the Control Panel.
The "Uninstall or Change a Program" screen appears.

2. Select SG-Imaging and right-click to select "Uninstall".
The "Confirm Uninstall" dialog box appears.
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3. Click “Yes”
Uninstallation begins.

1.2 Connecting the Controller and PC

This section describes the method of connecting the controller and PC: Ethernet connection.
Multiple controllers can be connected on a single PC through an Ethernet interface. The communication
protocol is TCP/IP, and the connection method is point-to-point.

Notes:
 Do not set the same IP address on the controller and PC.
 It is not possible to operate multiple controllers simultaneously on a single PC.
 It is not possible to operate a controller simultaneously on multiple PCs.

Connection method

1. Insert a commercial Ethernet cable (CAT-5 crossover cable) into the Ethernet interface on the controller.

2. Insert the other end of the Ethernet cable into the LAN interface of the PC.

 Connect two or more controllers

A hub that supports 100BASE-TX or 10BASE-T.
To connect the controller to the hub or the PC to the hub, use a commercial straight-through Ethernet cable.
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2 Basic Operation

2.1 Process Before Measurement

 Install SG-Imaging on the computer.

[Software Installation] (Page 6)

 Connect the controller and sensing head.

[Connecting the Controller and PC] (Page 7)

According to the [Measurement Settings] of SG-Imaging, set the system and measurement method as needed.

[STEP1: System Settings] (Page 24)

[STEP2: Measuring Method] (Page 26)

According to the measurement settings, display the measurement results on SG-Imaging.

[The Names and Functions of Each Part of the Master Interface] (Page 12)

[Measured Value Monitoring] (Page 53)

[Data Memory] (Page 58)

Preparation before measurement

Set measurement conditions

Display measurement results
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2.2 Start and Exit

This section describes the methods for starting and exiting SG-Imaging.

Start

Notes:
 It's unable to run multiple SG-Imaging instances.
 When you start two or more SG-Imaging instances, the screen will display a message indicating that

[SG-Imaging has been started].
 The controller cannot communicate when in "Program Setting Mode".
 Starting in online mode

1. Connect the computer and controller with SG-Imaging installed using an Ethernet cable.
[PC Communication Settings] (Page 57).

2. From the Windows Start menu, select "All Programs" - "SG-Imaging" - "SG-Imaging.exe".
Alternatively, double-click the SG-Imaging icon on the desktop.

SG-Imaging starts and automatically reads the settings of the controller.

If the connection to the controller fails, please click [PC Communication Settings] to confirm if the IP
address of the controller is correct.
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 Starting in offline mode

1. Ensure that the computer with SG-Imaging installed is not connected to the controller.
2. From the Windows Start menu, select "All Programs" - "SG-Imaging" - "SG-Imaging.exe".

Alternatively, double-click the SG-Imaging icon on the desktop.

SG-Imaging starts and displays a prompt message.

3. Click [to Offline Mode].

Display the [Settings Selection] screen.

4. Select the settings displayed at startup

When reading from a file
Select [Reading a File], click [OK].

Please select the "SG-Imaging settings file (*.sgtx)" on the [Open Files] dialog box, and then click [Open].

 If you click [Cancel], it will start with default values.
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When starting with default values
Select [Start with default values] and click OK.

 After selecting [Start with default values], the settings of the computer will become the default values.
The settings of the controller will not be initialized.

5. Confirm to start SG-Imaging in offline mode

Starting without connecting to the controller (offline mode)

Exit

1. If it's in measuring, click [Stop] to stop SG-Imaging from running.

2. Select the [File] menu ->[Exit].

Display the [Confirm Exit] dialog box.

3. Click “OK”

Close the screen and exit SG-Imaging.
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2.3 The Names and Functions of Each Part of the Master Interface

If the controller is connected and measurement begins, the current measurement value and trend chart will be
displayed.

(1) Menu Bar
Select menus for settings. (Page 13)

(2) [START] / [STOP] button
Switch to start or obtain measurement values from the trend chart. (When communication is not established,
display the [Connect] button for starting communication.)

(3) Measurement values display area
Display the current measured values and determined results. (Page 15)

(4) Buttons to change waveform display
Change the display mode of the waveform. (Page 16)

(5) Trend chart displaying area
Use a trend chart to display the temporal variation of measured values.

(6) Buttons for measurement processing
Perform "zero", "timed", and "reset" processing on the measured values. (Page 16)
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(7) [Measurement Settings] button
Set the program content currently in use (system settings, measurement methods). (Page 22)

(8) [Environment Settings] Button
Display the [Environment Settings] screen. (Page 44)

(9) Programs displaying area
Display the program currently in use. The program used can be changed from the drop-down menu. (Page 19)

(10) [Settings] Button
Display the [Program Settings] screen and perform program initialization, copying, etc. (Page 16)

(11) Displaying OUT number
Display the OUT changes in the trend chart, and you can use to switch the OUT number.

(12) Data displaying area
1)[Basic Settings] tab, [Tolerance/Offset] tab
Display the main setting conditions. If the setting is changed, it will be applied immediately.

2)[Statistics] tab
Display statistical information for cursor A/B.

Select menus for settings.

[File] Menu

Options Description

Save settings to a file  [Save settings to a file] (Page 51)

Open settings file  [Read Setting Files] (Page 51)

List of setting values  [Display settings content] (Page 52)

Exit  [Exit SG-Imaging] (Page 11)

[Monitor / Display] Menu

Options Description

Measured value
monitoring  [Measured value monitoring] (Page 53)

Menu Bar
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[Communication] Menu

Options Description

PC communication settings  [PC Communication Settings] (Page 57)

Connect/Disconnect Switching connections or disconnecting from
controllers

Send the set value to the
controller

Send the set values created on SG-Imaging to the
controller

Receive set values from the
controller

Read the set values from the controller into
SG-Imaging.

Factory reset
Restore the settings to factory settings.
(The content of the environment settings will be
initialized)

[Tools] Menu

Options Description

Data memory  [Data memory] (Page 58)

[Help] Menu

Options Description

Display "Help" Display "Help" for SG-Imaging (this Manual).

Version Display the version information of SG-Imaging.

Upgrading Upgrading for the controller and sensing head.

Registration Registration for Software License
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Display the current measured values and determined results.
When the measured value is within the tolerance range, the measured value is displayed as "green", and the [GO]
highlights for the determined result.

When the measured value is outside the tolerance range
The measured value is displayed in "red", and the [HI] or [LO] highlights for the determined result.

When it's unable to measure
The display of the measured value changes to "-FFFFFF", and [HI] and [LO] highlight for the determined

result.

When the determination in standby mode
The display of the measured value changes to "------", no signs highlight anyway.

Measured value displaying area

easured value
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Display the current measured values and determined results.

Options Description

Vertical zoom in
Zoom in/out on the vertical direction of the
trend chart.

Vertical zoom out

Horizontal zoom in

Zoom in/out on the horizontal direction of the
trend chart.

Horizontal zoom out

Vertical automatic adjustment Automatically adjust the vertical scale of the
trend chart according to the measured values.

Restore Restore the display of the trend chart.

Hide the cursor

Switch the display and selection of the cursor
on the trend chart.

Select cursor A

Select cursor B

Select cursor AB

Options Description

Switch the enable/disable of the zero function.

[Automatic zeroing function] (Page 19)

Switch the enable/disable of timed input.

[Maintain processing] (Page 39)

Restore inputs

[Maintain processing] (Page 39)

Click the [Settings] button to display the [Program Settings]

Buttons to change waveform display

Buttons for measurement processing

Settings button
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screen.

Initialize All
Perform initialization processing on all programs.

Initialize
Perform initialization processing on the selected program.

Copy
Copy the settings of the selected program.

Paste
Paste the copied program settings onto the selected program.

 [Environment Setting] is not a processing object for initializing/copying/pasting.

 [Basic Settings] tab
Display information on the [OUT Settings] and [Filter] of the current program being used.
 If the setting of the filter is changed, it will be applied immediately.
 You can also confirm the display of the photosensitive waveform.

 [Tolerance/Offset] tab
Display information on the current [Tolerance] and [Offset] of the program being used.

Data displaying area
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If the setting is changed, it will be applied immediately.

 [Statistics] tab
Display the [statistics] of the current program being used.
Click [Copy to clipboard], the statistical information will be copied to the clipboard in text format.
Statistical information can also be pasted into Excel files or other locations using the paste operation (Ctrl+V).

The following is an example of pasting into an Excel form.
Cursor A measured value 0.973

Cursor B measured value 0.973

Cursor A-B 0.000

Maximum value between cursor A-B 0.973

Minimum value between cursor A-B 0.973

Average value between cursor A-B 0.973
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This machine can switch between 8 programs (program numbers 00 ~ 07).
Log in various settings corresponding to different measurement objects as programs. You can call up the program
to change settings as needed.

 Environment settings are shared among all programs and it's not switched for any single program.

You can switch programs through the following methods.
 SG-Imaging：  [The Names and Functions of Each Part of the Master

Interface] (Page 12)
 Communication
commands:  [Switch program number] (Page 74)



This function can instantly change the measured value to 0.

 Under the following circumstances, automatic zeroing cannot be performed (automatic zeroing can be
released).
 Checking standby mode (display ------)

Automatic zeroing function

Measured value

Reference Value

Execute automatic zeroing

Time

Zeroing value

Program 07

Program 01

Program 00

Measurement Settings

System Settings

Measurement
Method

Automatic zeroing
value

Program functions
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 Outside the display range (display ±FFFFFF)
 Invalid data (display -FFFFFF)

 The values that are automatically zeroed will be saved according to each program number and each OUT
number.

 The values that are automatically zeroed will also be saved when the power is turned off.
 When the Maintain processing is not normal, the system will enter standby mode ("------") after setting
automatic zero.

 Automatic zeroing is the process performed on measured values that have already undergone Maintain
processing (Page 39)

Usage example

When aligning the standard workpiece at 10.000, please perform automatic zeroing after setting the

offset.

Execute/Release Automatic Zeroing

The following methods can be used to execute/deactivate automatic zeroing.

 Reset to zero through communication commands
 Set ON/OFF for automatic zeroing as "ON", execute the automatic zeroing request and perform
automatic zeroing on any specified OUT.

 Set ON/OFF for automatic zeroing as "OFF", execute the automatic zeroing request and release
automatic zeroing on any specified OUT.

 Reset to zero through button operation on SG-Imaging
 Click on the synchronous zero button on the "measured value monitoring" screen
Switch execution or release automatic zeroing for the specified synchronization setting of the OUT.

 Click the [Zero] button in each OUT display area
Switch execution or release automatic zeroing for each displayed OUT.

Measured value

Reference Value

Execute automatic zeroing

Time

Zeroing value
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3 Measurement Settings

3.1 Processing Flow of the Measured Data

Up to 4 sensing heads can be used for synchronous measurement on this machine. Additionally, up to 4
measurement methods (OUT01 ~ OUT04) can be used simultaneously to perform measurements. Each sensing
head can perform measurements separately and calculate measurement values between sensing heads.

 The measurement values from OUT01 to OUT04 can be used up to three times in the calculation.

Sampling

Median

Sensing Head 04
Measured Value

Sensing Head 04
Data Stream

Alarm Handling

Filter

Scale

Detection Mode

Automatic Zeroing

Offset

Tolerance
Comparator

OUT04 Measured
Value

OUT04
Data Stream

Sampling

Median

Sensing Head 04
Measured Value

Sensing Head 04
Data Stream

Alarm Handling

Filter

Scale

Detection Mode

Automatic Zeroing

Offset

Tolerance
Comparator

OUT04 Measured
Value

OUT04
Data Stream

Sampling

Median

Sensing Head 04
Measured Value

Sensing Head 04
Data Stream

Alarm Handling

Filter

Scale

Detection Mode

Automatic Zeroing

Offset

Tolerance
Comparator

OUT04 Measured
Value

OUT04
Data Stream
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3.2 Process of Measurement Setting

Click the [Measurement Settings] button on the master screen to display the settings screen for each STEP.
Set according to the screen display, and then transmit the set content to the controller to perform measurements.

1. Click the [Measurement Settings] button

2. Execute [STEP1: System Settings].

[STEP1: System Settings] (Page 24)

3. After setting, click [Forward].
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4. Execute [STEP2: Measurement Method].

[STEP2: Measurement Method] (Page 26)

5. After setting, click [Completed].

Perform measurements based on the set content.

 If you click [Exit] during the setting process, a confirmation screen will be displayed. If you need to send the
current settings to the controller, please click [Yes] button.
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3.3 STEP 1: System Settings



Confirm if the configuration of the sensing head connected to the controller is consistent.



The sampling period includes the time to obtain the photosensitive waveform and measure the distance to the
measured object.

Sampling frequency
Select the sampling frequency.
(SG5000 series: 590kHz/400kHz/200kHz/88kHz/50kHz/20kHz/10kHz/5kHz/2kHz/1kHz)
(SG3000/SGI series: 88kHz/50kHz/20kHz/10kHz/5kHz/5kHz/2kHz/1kHz)

Sensing Head Configuration

Sampling Settings
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(SC series: 10kHz/5kHz/2kHz/1kHz/0.5kHz)

Prevent mutual interference
By using this function, it is possible to avoid the illumination time of multiple sensor heads when using them
simultaneously, in order to avoid the mutual influence of sensor head light.

 OFF: Simultaneously emit light and sample.
 ON: Assign each sensing head from Group A to Group C. This setting can assign the sensing head to up to
three groups A to C and allow these groups to alternately emit light to prevent interference with each other.

 When setting the anti-interference function to AB-ON, the sampling period is twice the specified value;
When the anti-interference function is set to ABC-ON, the sampling time is three times the specified
value.

Synchronous settings, other settings

Synchronous settings

This function is used to set whether to use synchronous input control for each OUT.

Gating time
This function is used to set the time to turn on the gating output (single pulse output time).
There are four types of pulse widths available: 2ms/5ms/10ms/20ms.
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3.4 STEP 2: Measuring Method

Four measurement methods (OUT01 ~ OUT04) can be set. There are six measurement methods.
[Displacement (standard)] (Page 26)  [Displacement (semi-transparent object)] (Page 28)
[Displacement (Transparent Object)] (Page 29)  [Displacement (Transparent Object 2)] (Page 31)
[Displacement (reflective resin)] (Page 31)  [Calculation] (Page 31)

When measuring the height, displacement, positioning, vibration, bending, shape, etc. of an object
(non-transparent object), select this option.

1. Click the OUT button you want to set, such as OUT01, and click [Edit].

2. Select [Displacement (standard)] and click [OK].

Displacement (standard)
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3. Click on [Sensing Head Setting Value].

4. Confirm that a "white line" is displayed on the peak waveform.

For details, please refer to [ Sensing Head Setting Value] (Page 33).

 If there is no "white line", it may be mainly caused by the following reasons.

Reasons Troubleshooting

The measurement object is
outside the measurement range

Please check the location of the measurement
object

The amount of reflected light of
the measured object is too low Please reduce the sampling frequency

5. Click [OK] to close the [Sensing Head Setting Values] screen.
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6. Click on [Zoom, Tolerance Settings] as needed to set the processing of measured values.

For details, please refer to [Zoom, Tolerance Settings] (Page 38).

7. Click on the [Options] tab as needed to set the options.

For details, please refer to[ Option settings] (Page 39).



Use this option when the target will absorb laser brightness, such as semi-transparent plastics.

Please refer to [Displacement (standard)] (Page 26) for the measurement method settings of semi-transparent
objects.

Displacement (Semi-transparent Object)
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

When measuring the height, displacement, positioning, vibration, bending, shape, etc. of transparent objects,
select this option. This option is used when the reflectivity values of multiple surfaces of transparent objects are
the same.

1. Click the OUT button you want to set, such as OUT01, and click [Edit].

2. Select [Displacement (Transparent Object)] and click [OK].

3. Set the surface you want to measure.
 When measuring the displacement on the surface of a transparent object, set the peak value of the measured
object to [The first peak value] as shown in the following picture.

 When measuring the displacement of the back of a transparent object, set the peak value of the measured
object to [The second peak value].

Displacement (Transparent Object)
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4. Click on [Sensing Head Setting Value].

5. Confirm that "white lines" are displayed on both peak waveforms.
When the measured surface (of transparent object) is detected, the two peak waveforms of "surface reflection"
and "back reflection" of the transparent object will display "white lines" respectively.

For details, please refer to [ Sensing Head Setting Value] (Page 33).
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 If there is no "white line", it may be mainly caused by the following reasons.

Reasons Troubleshooting

The measurement object is
outside the measurement range

Please check the location of the measurement
object

The amount of reflected light of
the measured object is too low Please reduce the sampling frequency

6. Click [OK] to close the [Sensing Head Setting Values] screen.

7. Click on [Zoom, Tolerance Settings] as needed to set the processing of measured values.
For details, please refer to [Zoom, Tolerance Settings] (Page 38).

8. Click on the [Options] tab as needed to set the options.
For details, please refer to[ Option settings] (Page 39).



When measuring the height, displacement, positioning, vibration, bending, shape, etc. of transparent objects,
select this option. This option is used for multiple surfaces of transparent objects, such as when the reflectivity
values of the front and back are different (up to four surfaces).

 The sampling frequency of transparent object 2 cannot exceed 20kHz.
Please refer to  [Displacement (Transparent Object)] (Page 29) for the measurement method settings of
Transparent Object 2.



This option is suitable for plastic objects with strong surface reflection.

Please refer to [Displacement (standard)] (Page 26) for the measurement method settings of reflective resin
objects.



When only one OUT (measurement method) cannot obtain the desired value, select this option.

 It's unable to set only calculations for OUT.
 Please set the OUT calculation when other measurement methods have already been set.

1. Click the OUT button you want to set, such as OUT01, and click [Edit].

Displacement (Transparent Object 2)

Displacement (Reflective Resin)

Calculation
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2. Select [Calculation], and then click [OK].

3. Select the calculation method and set [Formula] or [Object OUT].

When selecting [Formula]
Set the Object OUT used in the formula.

When selecting [Ave/P-P/Max/Min]
Check the checkbox for the Object OUT of the calculation.
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 Ave: Calculate the average value of the Object OUT.
 P-P: Calculate the maximum - minimum value of the Object OUT.
 Max: Calculate the maximum value of the Object OUT.
 Min: Calculate the minimum value of the Object OUT.

Usage example
Use three sensing heads to measure the left, center, and right ends of the object at three points. When
calculating the bending amount of the measured object, set it as follows.
 OUT01: Using the sensing head 01
 OUT02: Using the sensing head 02
 OUT03: Using the sensing head 03
 OUT04: [Measurement Method] Calculation: P-P

[Object OUT] OUT01, OUT02, OUT03

4. Click on [Zoom, Tolerance Settings] as needed to set the processing of measured values.

For details, please refer to [Zoom, Tolerance Settings] (Page 38).

5. Click on the [Options] tab as needed to set the options.

For details, please refer to [ Option settings] (Page 39).

Sensing Head Setting Value

Waveform displaying area
As a standard for determining whether the measurement is correct, confirm the waveform of the photosensitive
peak from the measured surface.
All of the following conditions must be met.
 Stable white line displayed on the photosensitive peak.
 The height of the photosensitive peak is above 10.
 The waveform of the photosensitive peak does not show significant distortion, such as it's divided into two
halves around the peak.

Universal Setting Items
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When the measurement method is for transparent object 2, it can display the photosensitive peak waveform
after processing four ABLE values.

No. Options Description

(1) [Obtaining terminated] / [Obtaining
started]

Switch to start/stop obtaining the
photosensitive peak waveform.

(2) Buttons to change waveform display Change the display mode of the waveform.

(3) Peak waveform Display the photosensitive peak waveform.

 [Universal Settings] Options



Shenzhen SinceVision Technology Co., Ltd. www.cnsszn.com

35 ©2024 All rights reserved by SinceVision

Median

Applying median filters of 7, 15, or 31 points to the measured values can remove sharp changes in the
measured values and suppress deviations in the measured values. Set this item when the measured object is
moving at high speed.

 Setting range: OFF (default), 7, 15, 31

ABLE (Light Quantity Control)

Choose the type for adjusting the amount of light and sensitivity.

 AUTO: Automatically adjust the appropriate amount of light and sensitivity.

 MANUAL: Adjust the amount of light and sensitivity within the range of 1-99. Choose this option
when the period of measuring the reflectivity of an object is fast and there is a significant

change.

 When measured objects with high reflectivity (mirrors, etc.) are outside the measurement range and an
incorrect measured value is detected, select [MANUAL] to lower the upper limit value, which can
sometimes be resolved the incorrect measured value.

Tuning the amount of light

Optimize the adjustment range of light amount and sensitivity by measuring the actual measured object.

Click [Start] while capturing the actual measured object. After any time, please click [Stop].

Dark (Only supports SC series point spectral sensors)

By measuring background light and setting an effective threshold, the influence of background light can be
eliminated.

Example of using a median filter with 7 points

Arrange the measured results at 7 points in ascending order, with the central value as the measured
value.Measured times
Measured value

Median 1st time

Median 2nd time

Median 3rd time

For example, when the median is executed for the first time, the order from (1) to
(7) becomes the following, with the central value of "1.0" being the measured value.
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When the waveform of the light intensity displayed on the measured object is shown in the following figure,
it indicates that the system is affected by background light.

When moving the sensing head out of the measurement range or when the sensing head is obstructed,
click and the following prompt will pop up:

After confirming the status of the sensing head, click [OK] to enter the automatic detection process (as shown below).

After completion, the waveform of the light intensity displayed on the measured object is shown in the following figure.

Shielding Settings

Set boundaries and mask the measurement range.

Shielding Boundary

When [Shielding Setting] is ON, specify the shielding boundary with [Boundary 1] and [Boundary 2].

 When [Boundary 1] < [Boundary 2]: the outer sides of [Boundary 1] and [Boundary 2] are shielded.

 When [Boundary 1] > [Boundary 2]: the area between [Boundary 1] and [Boundary 2] are shielded.

 When [Boundary 1] = [Boundary 2]: No shielding is performed.

 The boundary of shielding can be set in units of 0.01mm. When it is less than 0.01mm, automatic
processing will be performed internally.
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Datum point

If there are multiple peaks when using the measurement method of a transparent object, the peak of the
distance sensing head NEAR or FAR can be used as the reference point.

LASER CTRLGroup

This function is used to control laser operations, such as dividing two or more sensing heads into two groups
for on/off operations. This is very useful when the sensing head is used on different production lines.

Reflective selection mode (does not support SC series point spectral sensors)

Set the installation mode of the sensing head (diffuse or mirror reflection).

Choose mirror reflection mode when the object is a mirror, glass panel, or other similar object.
 [Alarm Error] Tab

Number of Mistakes

Set the number of cycles to retain the latest valid measured values (setting range: 0 to 9999).

Number of Mistakes Operation

0 Handle alarms immediately

1~9998 Keep the latest valid measured values

9999 No alarm to be handled

Recovery times

Set the number of cycles measured before recovering from the alarm state (setting range: 0 to 99).

Alarm Level

Set alarm sensitivity from low (0) to high (9) (default value: 4).

 Low (0): reduce the sensitivity of alarm detection

 High (9): Enhance the sensitivity of alarm detection
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Zoom, Tolerance Settings

Zoom
The display value of each OUT measured value can be scaled arbitrarily. It is to scale the displayed values for
any two points separately.
The measured values obtained by clicking on [Set from Current Value] can be assigned to [Actual Value 1] and
[Actual Value 2]
 Scaling must meet the following conditions, otherwise please reset.
 Actual Value 1 – Actual Value 2 ≠ 0
 | Display value 2 – Display value 1 | / | Display value 2 – Display value 1 | ≤ 2

Tolerance Comparator

Upper/lower limit value
Set the tolerance (upper limit value, lower limit value) used to determine the measured value.
Measured values can be determined according to the following three levels, and the results can be displayed
and output.
 When it is above the upper limit value (HI)
 When within the tolerance range (GO)
 When it is below the lower limit value (LO)

Delay

If the measured value is located near the determined value of tolerance and moves up and down, sometimes
the determined output will repeatedly between ON or OFF. Setting [Delay] can prevent the occurrence of
this state. The defaut delay value before out of factory is set to "None (0.000 mm)"
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Option Settings

Filter
Perform moving average filtering on the measured values.

 Times of Average: Set the number of measured values to be averaged.

The processing method of moving average
Perform moving average processing on the measured values within the range of 1-262144 times.
The processing for setting 4 averages is as follows.

Maintain processing
Choose a method to maintain processing.

General

Continuously output measured values.

Sampling cycle

Internal data

Output data

Update cycle

Average
measured time

Average
measured time

Average
measured time Averaging data 1-4 and output data A.

Averaging data 2-5 and output data B.

Averaging data 3-6 and output data C.

General
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Peak Hold

Output the maximum value during the sampling period.

 Update condition: [External timing 1]

 Update condition: [External timing 2]

Valley Hold

Output the minimum value during the sampling period.

 Update condition: [External timing 1]

 Update condition: [External timing 2]

Peak Hold

Mximum value

Sampling cycle

Timing Input

Sampling
cycle

Sampling
cycle

Timing Input

Sampling
cycle

Timing Input

Sampling
cycle

Timing Input

Valley Hold

Minimum value
Sampling cycle
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Peak to Peak Hold

Output the maximum value - minimum value during the sampling period.

 Update condition: [External timing 1]

 Update condition: [External timing 2]

Sampling Hold
Output measurement values based on update time.

 Update condition: [External timing 1]

 Update condition: [External timing 2]

Minimum display unit
Select the minimum display unit for the measured value.

Peak to Peak Hold

Max. - Min.
value

Sampling cycle

Sampling
cycle

Timing Input

Sampling
cycle

Timing Input

Sampling Hold

Sampling Hold Value

Timing Input

Timing Input Sampling cycle
(=sampling period x average number of times)
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Analog output scaling
Set the analog range to represent the measured value, and you can choose to output analog voltage or analog
current.
Analog voltage output can be set to the desired voltage range within the range of 0-10V; The analog current
output can be set to the desired current range within the range of 4-20mA.

 Output type selection

You can choose to control the type of analog output from the following options:

 OFF (Pictrure 3- 1)

 Voltage (Pictrure 3- 2)

 Current (Pictrure 3- 3)

Pictrure 3- 1 Turn off analog output

Pictrure 3- 2 Analog voltage output

Pictrure 3- 3 Analog current output

 Set the corresponding relationship between analog output and measured values

1) Assuming that the scaling parameters for analog output are set as shown in Picture 3- 4 or Picture
3- 5:

Picture 3- 4

Picture 3- 5

1) The corresponding relationship between the analog output and the measured value is shown in
Picture 3- 6:
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Picture 3- 6

 When the measured value is +5mm, the analog output is 10V or 20mA, and when it exceeds
+5mm, it still outputs 10V or 20mA;

 When the measured value is -5mm, the analog voltage output is 0V or 4mA, and when it is
lower than -5mm, it still outputs 0V or 4mA;

 Calculate the analog output based on the following formula for measured values between
-5mm and +5mm:

Outputvoltage V =
Currentmeasuredvalue − Measuredvaluelowerlimit

Measuredvalueupperlimit − Measuredvaluelowerlimit
× Outputvoltageupperlimit − Outputvoltagelowerlimit

+ Outputvoltagelowerlimit

Output current � =
Currentmeasuredvalue − Measuredvaluelowerlimit

Measuredvalueupperlimit − Measuredvaluelowerlimit
× Output current upper limit − Output current lower limit

+ Output current lower limit

2) When the measured value is the alarm value (± FFFFFF) or the standby value (XXXXXX/-------),
the analog voltage output is 11V and the analog current output is 24mA.

Notes:

a) Measured value upper limit must be greater than the measured value lower limit.

b) Output voltage (current) upper limit must be greater than output voltage (current) lower
limit.

Analog output

Measured value
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4 Universal Settings and Functions

4.1 Environment Settings

Click the [Environment Settings] button on the master screen to display the [Environment Settings] screen.

If the program change setting is transmitted to the controller, it will be immediately applied.

1. Click on [Environment Settings] on the master screen.

2. Perform [Environmental Settings].

 [Communication Settings] (Page 45)
 [Program Change Settings] (SGI series not supported) (Page 45)
 [Encoder Settings] (Page 46)
 [Input/Output Settings] (SGI series supported only) (Page 49)
 [Invalid Value Output Format Settings] (Page 50)
 [OUT Quantity Settings] (Page 50)
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

Set the communication settings for the connected controller to RS-232C (RS485)/Ethernet.

RS-232C(RS485) Settings

When using RS-232C communication, make relevant settings.

Baud rate
Set the baud rate for RS-232C communication.
 Options (unit: bps): 9600 (default)/19200/38400/57600/115200

Parity check
Set the parity check for RS-232C communication.
 Options: Even/Odd/No Parity (default)

Automatic sending (not support SGI series laser displacement sensors)
Set automatic sending.
 Option: OFF (default)/ON.

Ethernet Settings

When using Ethernet communication, make relevant settings.

IP address/subnet mask/gateway
Set the IP address, subnet mask, and gateway of the controller.

The settings will only be applied the next time the controller is started.



Communication Settings

Note:

Program Change Settings (not support SGI series laser displacement sensors)
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Perform program change settings.

Program Change
This function is used to select whether to switch program numbers through SG-Imaging or external terminal

input.
Option: Panel (default)/Terminal.

Encoder Settings

Set the function of the encoder signal and control the input method of the encoder signal.

Running Mode
Select the running mode of the encoder signal.
 Options:

 OFF： Encoder input signal not working.
 Timing: The encoder input signal is used as a synchronous timing signal, and the trigger

frequency of the signal is ≤ 4kHz;
 Trigger: The encoder input signal is used as the trigger signal of the sensing head to sample the

measured value.
The signal frequency should be less than the sampling frequency set in [Sampling
Settings] (Page 24). For signals exceeding the sampling frequency, the measured value
will output an alarm value.

Input Mode
Select the input method for the encoder pulse signal.
 Options:

 1 phase 1 increment (no orientation)
It's not related to the input of phase B, the pulse count value increases on the rising edge of phase
A.
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 2 phase 1 increment
 When phase B is OFF

 Identify the signal input at the rising edge of phase A and add a pulse count value.
 Identify the signal input at the falling edge of phase A, subtract the pulse count value.

 When phase B is ON
 It does not identify signal inputs and not update pulse count values.

 2 phase 2 increment
 When phase B is OFF

 Identify the signal input at the rising edge of phase A and add a pulse count value.
 Identify the signal input at the falling edge of phase A, subtract the pulse count value.

 When phase B is ON
 Identify the signal input at the rising edge of phase A and subtract a pulse count value.
 Identify the signal input at the falling edge of phase A, add the pulse count value.

Phase A

Phase B

Pulse count value

Phase A

Phase B

Pulse count value

Phase A

Phase B

Pulse count value
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 2 phase 4 increment
The pulse count value is determined by the phase of phase A and phase B.
When phase A is before phase B, add the pulse count value; when phase A is behind phase B,
subtract the pulse count value.
 When phase B is OFF

 Identify the signal input at the rising edge of phase A and add a pulse count value.
 Identify the signal input at the falling edge of phase A, subtract the pulse count value.

 When phase B is ON
 Identify the signal input at the rising edge of phase A and subtract a pulse count value.
 Identify the signal input at the falling edge of phase A, add the pulse count value.

 When phase A is OFF
 Identify the signal input at the rising edge of phase B and subtract a pulse count value.
 Identify the signal input at the falling edge of phase B, add the pulse count value.

 When phase A is ON
 Identify the signal input at the rising edge of phase B and add a pulse count value.
 Identify the signal input at the falling edge of phase B, subtract the pulse count value.

Intervals
Set the interval between "trigger" or "timing" signals for the increase or decrease of pulse count values.
 Set value: 1-10000 (default: 200)
Orientation Detection
Choose whether to emit a "trigger" or "timer" signal when the pulse count increases or decreases.
 Options: Clockwise & Counterclockwise timing (default)/Clockwise timing/Counterclockwise timing
Minimum input time
Set the minimum pulse width time for A/B/Z phase pulse input.
 Option: 100ns (default)/200ns/500ns/1μs/2μs/5μs/10μs/20μs

Phase A

Phase B

Pulse count value
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Input/Output Settings (SGI series laser displacement sensors supported only)

Set the functions and corresponding electrical characteristics of input and output ports.

Input:

The functions of setting two input IO ports.

 Options:

 OFF: Input ports 1 and 2 are not effective.

 Timing/Zeroing: Input port 1 serves as the synchronous timing input port, and input port 2

serves

as the synchronous zeroing input port.

 Encoder: Input port 1 serves as the A-phase input port of the single-ended encoder, and

input port 2 serves as the B-phase input port of the single-ended encoder (24V

signal supported only).

Input/output electricals:

Set the electrical type of the digital input/output port.

 Options: NPN/PNP

Digital output:

Set the digital output ports (HI, GO, LOW, STORE) as comparators for which measured item (OUTx) to

output.

 Options: OFF/OUT01/OUT02/OUT03/OUT04

Analog output:

Set the analog output port as the measured result output for which measured item (OUTx).

 Options: OUT01/OUT02/OUT03/OUT04
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Invalid Value Output Format Settings

Modifying the format definition of invalid values will affect the display of invalid values on the interface and the

return value format of communication protocols.

Output format:

 FFFFFFF: Format 1

 9999999: Format 2

Note:

FFFFFFF (Format 1) 9999999 (Format 2)
Description

Display value Output value Display value Output value

-------- XXXXXXXX -------- -9999998 Standby

data

±FFFFFFF ±FFFFFFF ±9999999 ±9999999 Out of range

-FFFFFFF -FFFFFFF -9999999 -9999999 Invalid data

OUT Quantity Settings (firmware support required)

Switch the system to use 4 OUT calculation items or 8 OUT calculation items.

OUT Quantity:

4: Use four universal calculation items.

8: Use 4 universal calculation items and 4 calculation items with only calculated functions.
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4.2 Save and Read Settings



Save the current settings to a file.

1. Select the menu [File] -> [Save Settings to a File].

2. Set the saving location and file name, and then click [Save].



Read the settings file saved in the computer.
You can choose to transfer the read content to the controller or edit it in offline mode.
1. Select the menu [File] -> [Open Settings File].

2. Select the reading method for the file, and then click [OK].

 If you choose [Edit in Offline Mode], you can open any settings file for editing.
3. After selecting a file, click [Open].

Save settings to a file

Read Setting Files
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When selecting "Transfer File Content"
When transferring the read file content to the controller, a file transfer progress bar will be displayed.

After the file transfer is completed, a prompt message screen will be displayed.

When selecting "Edit in Offline Mode"
Read the file content and start in offline mode.



You can view the current Set Value List.
You can also paste the content copied to the clipboard into Excel for viewing.

Display Settings Content
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1. Select the menu [File] -> [Set Value List].

Display [Set Value List] screen.

2. Click [Copy the Set Value List to the Clipboard].

3. Paste into Excel and view the list.
[Sensing Head Setting Value] [Sensing Head 01] [Sensing Head 02] [Sensing Head 03] [Sensing Head 04]
Detection Mode Standard Standard Standard Standard
Datum Point NEAR NEAR NEAR NEAR
ABLE AUTO AUTO AUTO AUTO
ABLE Setting range Upper Limit --- --- --- ---

Lower Limit --- --- --- ---
Reflective Selection Mode Diffuse Reflection Diffuse Reflection Diffuse Reflection Diffuse Reflection
Median OFF OFF OFF OFF
LASER CTRL Groups LASER CTRL 2 LASER CTRL 2 LASER CTRL 2 LASER CTRL 2

Shielding Settings OFF OFF OFF OFF
Shield Boundary POS-1 --- --- --- ---

POS-2 --- --- --- ---

Alarm Error Number of Mistakes 8 8 8 8

Recovery Times 0 0 0 0
Alarm Level 4 4 4 4

4.3 Measured Value Monitoring

This section describes the "Measured Value Displaying" function for observing measured values on a PC.

1. Select the Menu [Monitor / Display] -> [Measured value monitoring]
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(1) Start to obtain measured values

Start to obtain measured data from the controller.
After clicking "Start to obtain measured values", the button will change to "Stop to obtain measured values".

(2) Display measured data after applying "Synchronous Zero", "Synchronous Reset" or "Synchronous

Timing".

Synchronous Zero
Apply simultaneous zeroing to the specified OUT.
Synchronous Reset
Apply simultaneous re-setting to the specified OUT.
Synchronous Timing
Apply simultaneous timing to the specified OUT.

(3) Select “OUT”

Check the OUTs to be displayed.

(4) Display measured data after applying "zero", "reset", or "timing".

Zero
The current measured data is set to the reference value (zero) and displayed.
For details, please refer to [Automatic zeroing function] (Page 19)。

Reset
Display the measured values after resetting the operation of the measurement mode and the filter to default
values.
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Timing
Switch the timing function between ON and OFF.
Note:When the synchronous setting is checked for the selected OUT, the "Timing" button will be disabled.

Reference: The display status of the measured data is shown in the table below.

Status Range Display
HIGH HI value < measured value When “HI” highlights, measured value is displaying in red.

GO
LO value <= measured value <= HI
value

When “GO” highlights, measured value is displaying in
green.

LOW Measured value < LO value When “LO” highlights, measured value is displaying in red.
STANDBY Measured value is displaying in “-------”.

ALARM
When “HI” and “LO” highlights, measured value is
displaying in “-FFFFFF”.

(5) Sensing head status
Display the status of the sensing head.

(6) Help

Open the SG-Imaging Help file.

(7) Exit

Turn off "Measured Value Display".
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4.4 Terminal Monitoring

This section describes the "Terminal Monitoring" function of observing signals from the input terminal on
a PC.
1. Select the menu [Monitor / Display] -> [Terminal Monitoring].

(3)
(4)
(5)
(6)

(1)

(2)
(7)

(1) Input signal display area

The input signal will be displayed in a high or low logic level, with high level when there is no input and low

level when there is input.

The entire monitoring process will collect the status of input ports for 1,000,000 times, and the collection

interval is calculated based on the "monitoring time".

Description of each port definition:

Port Description
Controller

pins

TIMING_ENCO Timing signals input to and converted by the Encoder --

RESET Reset input (binary selection) 8

ZERO Automatic zeroing input (binary selection) 7

TIMING Timing input (binary selection) 6

RESET_SYNC Reset (sync.) input 5

ZERO_SYNC Automatic zeroing (sync.) input 4
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TIMEING_SYNC Timing (sync.) input 3

ENCODE_Z Encoder Z-phase input 41, 42

ENCODE_B Encoder B-phase input 39, 40

ENCODE_A Encoder A-phase input 37, 38

(2) Monitoring time

The total time for monitoring input signals, ranging from 1 to 60 seconds, corresponds to a signal-obtaining

interval of 1 to 60μs.

(3) Start to obtain

Start to obtain input signal data from the controller.

After clicking "Start to obtain", the button will change to "Stop to obtain".

(4) Scaled down horizontally

Scaled down horizontally the input signal chart.

(5) Scaled up horizontally

Scaled up horizontally the input signal chart.

(6) Restore

Restore the default display scale of the input signal chart.

(7) Current encoders count value

Display the current encoder count value, which is based on 2147483648 as the reference point, and then

increase or decrease according to the input signal.

4.5 PC Communication Settings

Set the communication between the controller and SG-Imaging.

1. Select the menu [Communication] -> [PC Communication Settings].

The "PC Communication Settings" dialog box appears.



Shenzhen SinceVision Technology Co., Ltd. www.cnsszn.com

58 ©2024 All rights reserved by SinceVision

2. Input the IP address of the controller.

Assign an IP address to the controller

Specify the actual IP address of the controller to be connected.

Automatic search controller

Click "Search for Connected Controllers" to specify the controller to be connected.

3. Click [OK].

4. Click [Connect] to establish communication with the controller.

 If Ethernet communication establishment fails, the following dialog box will be displayed.

Please re-check the connection status of the Ethernet cable and whether the communication settings are

correct.

4.6 Data Memory

This section describes the method of changing data storage settings and information about the "data

storage" function for displaying measured results.

The name and function of the data storage settings window

Select the menu [Tools] -> [Data Storage].
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Reference: Up to 1.2 million measured values can be stored.

This window can display stored data:

 Storage data read from the controller.

 Storage data saved on the PC.

Reference:

 The size of the "Data Storage" window can be adjusted.

 It can only be enlarged based on the original window size.

(1) Start to store

Start to store data on the controller.
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(2) Stop to store

Stop to store data on the controller.

(3) Clear stored data

Clear the data stored on the controller.

Note: The "Clear stored data" function will clear all data stored on the controller.

(4) Status display

Display the status of data stored on the controller.

Reference:

The following status will be displayed:

Status Display Displayed amount of stored data

Disconnected Unconnected *****

Standard mode: store In storing The current amount of stored data

Standard mode: stopped Stopped The current amount of stored data

Communication error ***** *****

Other system error System error *****

(5) Data storage settings

Set the method for storing measured data. Please refer to "Data Storage Setting Process" (Page 62) for detailed

information.

(6) Storage data readout

Load stored data from the controller. Please refer to "Loading Stored Data" (Page 65) for detailed information.

(7) Waveform display control toolbar

Tile/Cascade Display

Set to display measured data waveforms in a stacked or cascading manner.

Zoom in/out

Vertically and horizontally Zoom in/out the measured data waveform.

Return to default display

Reset the display position that has been zoomed in/out or moved, and return to the default display.



Shenzhen SinceVision Technology Co., Ltd. www.cnsszn.com

61 ©2024 All rights reserved by SinceVision

Automatic adjustment

Automatically adjust the vertical scale to fit the display area.

Cursor

Hide cursor.

Cursor

Select and display the cursor.

(8) Waveform Name

Set user-defined waveform names.

Notes:

 The waveform name can contain up to 8 alphanumeric characters, except for commas and periods, or 8

double-byte characters.

 The waveform name can only be set after the waveform is displayed.

(9) Waveform color

The color of the waveform display.

(10) Display location

Move the display position of the waveform.

Note: The display position can only be moved after the waveform is displayed.

(11) Waveform display of measured data

Display the loaded measurement data.

(12) Cursor information

Display cursor information in a table format.

(13) Help

Open the SG-Imaging Help file.

(14) Exit

Close the "Data Storage" window.

(15) Save to file
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Save the stored data to a file (save as a CSV file).

(16) Reading files

Load storage data from a file.

Data Storage Setting Process

1. Click on "Data Storage Settings".

Set the target OUT, data storage capacity, and storage period.

Please refer to "Changing Data Storage Settings"(Page 64) for detailed information.

2. Click "Start to store ".

The controller starts storing measured data.

When the amount of stored data reaches the value set in "Storage Data Volume", the storage automatically

stops.

Reference:

 Click "Stop to store" to pause data storage.

 After pausing, you can click "Start to store" again to continue storing data from the paused location.

3. Click on "Stored Data Readout".

The "Read Accumulated Data" dialog box appears.

Please refer to "Loading Stored Data" (Page 65) for detailed information on loading storage data.

4. Click "Readout".

The data stored in the controller is transmitted to the PC.
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When the transmission progress bar reaches the right end, data transmission ends.
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Changing Data Storage Settings

In the "Data Storage" window, click "Data Storage Settings" to display the "Data Storage Settings" dialog box.

(1) Data storage capacity

Set the number of data points to store.

(2) Storage cycle

Set the interval for data storage.

(3) Received from controller

Upload the set values from the controller.

(4) Send to controller

Download the set values to the controller.

Note:When uploading and downloading data, the controller will enter communication mode.

(5) Exit

Close the "Data Storage Settings" window.

(6) Specify OUT for Data Storage
Check the OUT where you want to store data.
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Loading Stored Data
In the "Data Storage" window, click "Stored Data Readout" to display the "Read Accumulated Data" dialog box.

(1) Data 01 to Data 04

Set the loading targets for each data from 01 to 04.

(2) Readout

Start loading stored data.
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5 Communication Commands

This section describes the commands for communicating with the controller.

5.1 Specifications

 SG/SC series support RS232 interface communication with external devices.

RS232 Interface Description

Terminal
number

Signal name Description

55 RS232_TX Sending signals to external devices
56 RS232_RX Receive external device signals
57 RS232_GND Ground wire

RS232 Communication Parameters

Sending method Full duplex
Sending codes ASCII
Data length 8 bits
Stop bit 1 bit
Parity check None/Odd/Even
Baud rate 9600/19200/38400/57600/115200 bps
Data delimiter \r\n

 Please refer to [Communication Settings] (Page 45).
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 The SGI series supports RS485 interface communication with external devices.

RS485 Communication Parameters

Sending method Half-duplex
Sending codes ASCII
Data length 8 bits
Stop bit 1 bit
Parity check None/Odd/Even
Baud rate 9600/19200/38400/57600/115200 bps
Data delimiter \r\n

 Please refer to [Communication Settings] (Page 45).

 SG/SC/SGI series support network interface communication with external devices.

RJ45 (Ethernet port) communication parameters

Connection method TCP Client
Communication port 19062
Sending codes ASCII
Data delimiter \r\n

 Please refer to [Communication Settings] (Page 45) for network IP address modification.
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5.2 Command Format Overview

Control operations based on commands passed in from external devices, and then send response commands to
external devices. \r\n is used to separate each data in the incoming/response command format.

Incoming command format

Response command format

Incoming command

Response command

\r\n

\r\n

Note: When creating a control program, the program built should allow you to send the next command after
confirming that you have received a response command from the sensor.

Reference:

Both uppercase and lowercase characters can be used in commands.
Whether the part enclosed in square brackets appears in the command format depends on the condition.
 Error response command format

The following table lists the main error codes.
Response ER, (Command sent), (Errors) \r\n

Error codes

 50: Command error
 51: Status error
 60: Command length error
 61: Parameter count error
 62: Parameter range error
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Measured Value Format

The output format of the measured values is as

follows.

The following table provides some format examples.
Format 1※ Format 2※

Description
Display value Output format Display value Output format
1.2345 +01.2345 1.2345 +01.2345

Normal test value
-0.0120 -00.0120 -0.0120 -00.0120

1234.56 +1234.56 1234.56 +1234.56

-1.2 -00001.2 -1.2 -00001.2

0.000 +000.000 0.000 +000.000

-------- XXXXXXXX -------- -9999998 Standby data
±FFFFFFF ±FFFFFFF ±9999999 ±9999999 Out of range
-FFFFFFF -FFFFFFF -9999999 -9999999 Invalid data

※ Data format switching, please refer to [Invalid Value Output Format Settings] (Page 50)

Set value format (fffffff)

 Set Change Format

This format has a fixed length and consists of one symbol and six-digit numerical values. Excluding decimal
points.

 Set to obtain format

This format has a fixed length and consists of one symbol, six-digit numerical value, and one decimal point.

A fixed length data consisting of seven characters.
The decimal point is counted as one character.
The existence and placement of decimal points vary depending on the settings.
The measured values are right aligned.

Symbol Integer
Decimal
point Decimal

A fixed length data composed of one character, with values of "+" or "-"
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5.3 Mode Change Command

This section describes the command format used to switch between "General Mode" and "Communication
Mode".

Reference:

General Mode
During measurement

·Accept measurement control commands.
·Do not accept commands such as writing/reading set values.

During tolerance /
function setting period

·Do not accept communication.
·The measurement will stop.

Communication
Mode

·When receiving the commands "Q", "0", "\r\n", the mode will
change to communication mode and allow writing/reading of set
values.
·When in communication mode, the measurement will stop.

 Change to Communication Mode

Incoming command Q0\r\n

Response

commands
Q0\r\n

Parameter

Description
-

Error code ·Err-51: Currently in communication mode.

 Change to general mode

Change mode to normal mode

Incoming command R0\r\n

Response

commands
R0\r\n

Parameter

Description
-

Error code ·Err-51: Currently in general mode.
·Err-63: The number of times the same OUT value is reused in the calculation exceeds
the limit.
·Err-66: The calculation method parameters do not meet the requirements of the set list
(no OUT is specified for AVE, MAX, MIN, or P-P calculations).
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5.4 Measurement Control Commands

This section describes the command format used to control measurements. The incoming command is a command
that the sensor can receive during measurement, and the response command is a command sent after correctly
processing the incoming command.
The following sections contain detailed information about incoming commands and the response commands
issued after correctly handling them.
For detailed information on error response commands, please refer to "Command Format Overview" (Page 68).

Note: These commands can only be received when the controller is in "General mode".

 Measured value output (one)
Incoming command MS,aa\r\n
Response
commands

MS,aa,hhhhhhhh\r\n

Parameter
Description

·Only output measured values with the specified OUT number.
·aa: OUT number (value 01 to 08, 01: OUT01, 02: OUT02... 08: OUT08).
Note:When the OUT quantity is 4 (Page 50), the range of aa is 01~04. When the OUT
quantity is 8, the range of aa is 01~08.
·hhhhhhhh: Measured value format.

Error code -

 Measured Value Output (multiple)
Incoming command MM,iiii(iiiiiiii)\r\n
Response
commands

MM,iiii(iiiiiiii),hhhhhhhh[,hhhhhhhh…,hhhhhhhh]\r\n

Parameter
Description

·You can choose any numbered OUT from 4 or 8 to output measured values.
·iiii(iiiiiiii): When the number of OUT is 4 (Page 50), the number sequence format is
iiii. When the number of OUT is 8, the number sequence format is iiiiiii.
·iiii: Specify a numerical sequence of 1 (output) or 0 (no output) for each OUT
(Example: When specifying OUT02 and OUT04, the sequence is 0101).
·hhhhhhhh: Measured value format.

Error code ·Err-62: Specify all OUT as 0.
·Err-64: The specified OUT number exceeds the valid OUT range.

 Measured Value Output (all)
Incoming command MA\r\n
Response
commands

MA,hhhhhhhh,[,hhhhhhhh…,hhhhhhhh]\r\n

Parameter
Description

·All OUT measured values will be output.
·hhhhhhhh: Measured value format.

Error code -
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 Timing ON/OFF (one)
Incoming command TS,p,aa\r\n
Response
commands

TS,p,aa\r\n

Parameter
Description

·p: ON/OFF setting (0: OFF, 1: ON).
·aa: OUT number (value 01 to 04, 01: OUT01, 02: OUT02... 04: OUT04)

Error code ·Err-62: The synchronized OUT was specified.
·Err-64: The specified OUT number exceeds the valid OUT range.

 Timing ON/OFF (multiple)
Incoming command TM,p,iiii\r\n
Response
commands

TM,p,iiii\r\n

Parameter
Description

·p: ON/OFF setting (0: OFF, 1: ON).
·iiii: Specify a numerical sequence of 1 (output) or 0 (no output) for each OUT
(Example: When specifying OUT02 and OUT04, the sequence is 0101).

Error code ·Err-62: The synchronized OUT was specified.
·Err-64: The specified OUT number exceeds the valid OUT range.

 Timing ON/OFF (sync.)
Incoming command TP,p\r\n
Response
commands

TP,p\r\n

Parameter
Description

·This command applies to all synchronized OUT.
·p：ON/OFF setting (0: OFF, 1: ON).

Error code Err-62: There is no synchronized OUT.

 Automatic Zeroing ON (one)
Incoming command VS,aa\r\n
Response
commands

VS,aa\r\n

Parameter
Description

aa: OUT number (value 01 to 04, 01: OUT 01, 02: OUT 02... 04: OUT 04)

Error code Err-64: The specified OUT number exceeds the valid OUT range.

 Automatic Zeroing ON (multiple)
Incoming command VM,iiii\r\n
Response
commands

VM,iiii\r\n

Parameter
Description

iiii : Specify a numerical sequence of 1 (output) or 0 (no output) for each OUT
(Example: When specifying OUT02 and OUT04, the sequence is 0101).

Error code Err-64: The specified OUT number exceeds the valid OUT range.
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 Automatic Zeroing ON (sync.)
Incoming command VA\r\n
Response
commands

VA\r\n

Parameter
Description

This command applies to all synchronized OUT.

Error code Err-62: There is no synchronized OUT.

 Automatic Zeroing OFF (one)
Incoming command WS,aa\r\n
Response
commands

WS,aa\r\n

Parameter
Description

aa: OUT number (value 01 to 04, 01: OUT 01, 02: OUT 02... 04: OUT 04)

Error code Err-64: The specified OUT number exceeds the valid OUT range.

 Automatic Zeroing OFF (multiple)
Incoming command WM,iiii\r\n
Response
commands

WM,iiii\r\n

Parameter
Description

iiii: Specify a numerical sequence of 1 (output) or 0 (no output) for each OUT
(Example: When specifying OUT02 and OUT04, the sequence is 0101).

Error code Err-64: The specified OUT number exceeds the valid OUT range.

 Automatic Zeroing OFF (sync.)
Incoming command WA\r\n
Response
commands

WA\r\n

Parameter
Description

This command applies to all synchronized OUT channels.

Error code Err-62: There is no synchronized OUT.

 Reset (one)
Incoming command DS,aa\r\n
Response
commands

DS\r\n

Parameter
Description

aa: OUT number (value 01 to 04, 01: OUT 01, 02: OUT 02... 04: OUT 04)

Error code Err-64: The specified OUT number exceeds the valid OUT range.

 Reset (multiple)
Incoming command DM,iiii\r\n
Response DM\r\n
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commands
Parameter
Description

iiii: Specify a numerical sequence of 1 (output) or 0 (no output) for each OUT
(Example: When specifying OUT02 and OUT04, the sequence is 0101)

Error code Err-64: The specified OUT number exceeds the valid OUT range.

 Reset (sync.)
Incoming command DA\r\n
Response
commands

DA\r\n

Parameter
Description

This command applies to all synchronized OUT channels.

Error code Err-62: There is no synchronized OUT.

 Switch Program Number
Incoming command PW,o\r\n
Response
commands

PW\r\n

Parameter
Description

o: Program number (0 to 7).

Error code Err-62: The specified parameter exceeds the range defined by the parameter.

 Obtain the Current Program Number
Incoming command PR\r\n
Response
commands

PR,o\r\n

Parameter
Description

o: Program number (0 to 7).

Error code Err-51: Status error.

 Data Storage Starts
Incoming command AS\r\n
Response
commands

AS\r\n

Parameter
Description

-

Error code Err-51: The environment for executing commands is non-running mode.

 Data Storage Stopped
Incoming command AP\r\n
Response
commands

AP\r\n

Parameter
Description

-
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Error code Err-51: Status error.

 Data Storage Initialization
Incoming command AQ\r\n
Response
commands

AQ\r\n

Parameter
Description

-

Error code Err-51: Status error.

 Data Output of Data Storage

Incoming command AO,aa\r\n

Response

commands
AO,hhhhhhhh…,hhhhhhhh\r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT 01, 02: OUT 02... 04: OUT 04)

·hhhhhhhh: Measured value format
Error code Err-71: The specified OUT is not the corresponding OUT for the stored data.

 Status Output of Data Storage

Incoming command AN\r\n

Response

commands
AN,s,ddddddd[,ddddddd…ddddddd]\r\n

Parameter

Description

·s: Storage status (0: Data storage stopped, 1: Storing data)

·ddddddd: The actual stored data number (maximum 1200000 based on the specified

OUT number). The number of output values is the same as the number of OUT used, in

order of OUT01, OUT02...
Error code -

 Light Intensity Output of Sensing Head

Incoming command OT,aa\r\n

Response

commands
OT,aa,dddd\r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT 01, 02: OUT 02... 04: OUT 04)

·dddd: Light intensity value (0000~1023). The output light intensity value is the

maximum peak light intensity value of the sensing head.
Error code Err-64: The specified OUT number exceeds the valid OUT range.



Shenzhen SinceVision Technology Co., Ltd. www.cnsszn.com

76 ©2024 All rights reserved by SinceVision

5.5 Setting Change Command

The following sections contain detailed information about incoming commands and the response commands
issued after correctly handling them.

For detailed information on error response commands, please refer to "Command Format Overview" (Page 68).

Note: These commands are only accepted when the controller is in communication mode.

5.5.1 Sensing Head Settings

 Detection Mode

Incoming command SW,HB,M,qq,c\r\n

Response

commands
SW,HB\r\n

Parameter

Description

·qq: Sensing head number (value 01 to 04)

·c: Function number (0: General, 1: Semi-transparent object, 2: Transparent object, 3:

Transparent object, 2: Reflective resin)
Error code ·Err-62: “c” out of range.

·Err-64: The specified sensing head number exceeds the active sensing head count.

 Detection Mode

Incoming command SW,HB,B,qq,c\r\n

Response

commands
SW,HB\r\n

Parameter

Description

·qq: Sensing head number (value 01 to 04)

·c: Function number (0: NEAR, 1: FAR)
Error code ·Err-62: “c” out of range.

·Err-64: The specified sensing head number exceeds the active sensing head count.

 ABLE

Incoming command SW,HA,M,qq,m\r\n

Response

commands
SW,HA\r\n

Parameter

Description

·qq: Sensing head number (value 01 to 04)

·m: Mode (0: AUTO, 1: MANUAL)
Error code ·Err-64: The specified sensing head number exceeds the active sensing head count.

 ABLE Control Range

Incoming command SW,HA,R,qq,xx,xx\r\n
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Response

commands
SW,HA\r\n

Parameter

Description

·qq: Sensing head number (value 01 to 04)

·xx: Control range data (01 to 99). Values should be specified in the order of upper and

lower limits.
Error code ·Err-62: Not meeting the conditions of "upper and lower limits".

·Err-64: The specified sensing head number exceeds the active sensing head count.

 ABLE Calibration Starts

Incoming command SW,HD,S,qq\r\n

Response

commands
SW,HD\r\n

Parameter

Description
·qq: Sensing head number (value 01 to 04)

Error code ·Err-51: The sensing head specified for ABLE calibration is not yet connected or is
performing calibration.
·Err-64: The specified sensing head number exceeds the active sensing head count.

 ABLE Calibration Completed

Incoming command SW,HD,P\r\n

Response

commands
SW,HD\r\n

Parameter

Description
-

Error code Err-51: The command did not perform an ABLE calibration.

 ABLE Calibration Stopped

Incoming command SW,HD,C\r\n

Response

commands
SW,HD\r\n

Parameter

Description
The calibrated sensing head is automatically specified.

Error code Err-51: The command did not perform an ABLE calibration.

 Reflective selection mode (installation mode)

Incoming command SW,HE,qq,c\r\n

Response

commands
SW,HE\r\n

Parameter

Description

·qq: Sensing head number (value 01 to 04).

·c: Function number (0: Diffuse reflection, 1: Specular reflection).
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Error code ·Err-62: “c” out of range.
·Err-64: The specified sensing head number exceeds the active sensing head count.

 Median

Incoming command SW,HG,qq,c\r\n

Response

commands
SW,HG\r\n

Parameter

Description

·qq: Sensing head number (value 01 to 04)

·c: Function number (0: OFF, 1: 7, 2: 15, 3: 31)
Error code ·Err-62: “c” out of range.

·Err-64: The specified sensing head number exceeds the active sensing head count.

 LASER CTRLGROUP

Incoming command SW,HH,qq,c\r\n

Response

commands
SW,HH,qq\r\n

Parameter

Description

·qq: Sensing head number (value 01 to 04)

·c: Function number (0: LASER_CTRL1, 1: LASER_CTRL2)
Error code ·Err-62: “c” out of range.

·Err-64: The specified sensing head number exceeds the active sensing head count.

 Shielding settings

Incoming command SW,HF,qq,c,fffffff,fffffff\r\n

Response

commands
SW,HF\r\n

Parameter

Description

·qq: Sensing head number (value 01 to 04)

·c: Function number (0: OFF, 1: ON)

·fffffff: Set value format (valid digits: 6). The values should be specified in the order of

point 1 and point 2.
Error code ·Err-62: “c” or “fffffff” out of range.

·Err-64: The specified sensing head number exceeds the active sensing head count.

 Alarm Handling

Incoming command SW,HC,N,qq,nnnn,nnnn\r\n

Response

commands
SW,HC\r\n

Parameter

Description

·qq: Sensing head number (value 01 to 04)

·nnnn: Unsigned numerical value (0000 to 9999). Values should be specified in the

order of error counting and restoring counting.
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Error code ·Err-62: "nnnn" out of range.
·Err-64: The specified sensing head number exceeds the active sensing head count.

 Alarm Level

Incoming command SW,HC,L,qq,c\r\n

Response

commands
SW,HC\r\n

Parameter

Description

·qq: Sensing head number (value 01 to 04).

·c: Alarm level (0 to 9).
Error code ·Err-62: “c” out of range.

·Err-64: The specified sensing head number exceeds the active sensing head count.
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5.5.2 OUT Settings

 Calculation Method

Incoming command SW,OA,H,aa,ggg\r\n

Response

commands
SW,OA,aa\r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT01, 02: OUT02... 04: OUT04)

·ggg: Sensing head number (H01 to H04) or OUT number (O01 to O04), calculation

method (C01: ADD, C02: SUB, C03: AVE, C04: MAX, C05: MIN, C06: P-P)
Error code ·Err-64: The specified OUT number exceeds the valid OUT range.

·Err-66: "ggg" does not meet the specifications stated in the settings list.

 Measured Target

Incoming command SW,OA,T,aa,c\r\n

Response

commands
SW,OA,aa\r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT01, 02: OUT02... 04: OUT04)

·c: Function number (0: 1, 1: 2, 2: 3, 3: 4, 4: 1-2, 5: 1-3, 6: 1-4, 7:2-3, 8: 2-4, 9: 3-4)

Error code ·Err-62: “c” out of range.
·Err-64: The specified OUT number exceeds the valid OUT range.

 Calculation between OUTs (ADD, SUB)

Incoming command SW,OA,C,aa,jj,jj\r\n

Response

commands
SW,OA,aa\r\n

Parameter

Description

·Even if the calculation method is changed, the specified value will be retained.

·aa: OUT number (value 01 to 04, 01: OUT 01, 02: OUT 02... 04: OUT 04)

·jj: The OUT to be calculated (value 01 to 04), for example, when the calculation

formula is “OUT01+OUT02”, these two “jj” values will be “01” and “02”.

Error code ·Err-64: The specified OUT number exceeds the valid OUT range.

 OUT to be Calculated (AVE-P/P-MAX/MIN)

Incoming command SW,OA,M,aa,iiii\r\n

Response

commands
SW,OA,aa\r\n

Parameter

Description

·When the selected calculation method is “AVE”, “MAX”, “MIN”, or “P-P”, use this

command.

·Even if the calculation method is changed, the specified value will be retained.
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·iiii: This is a numerical sequence that specifies 1 (output) or 0 (no output) for each

OUT (example: when specifying OUT02 and OUT04, the sequence is 0101).

·aa: OUT number (value 01 to 04, 01: OUT01, 02: OUT02... 04: OUT04)
Error code ·Err-64: The specified OUT number exceeds the valid OUT range.

·Err-66: “iiiii” does not meet the specifications stated in the settings list.

 Detection Mode (measurement mode)

Incoming command SW,OD,aa,c\r\n

Response

commands
SW,OD\r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT 01, 02: OUT 02... 04: OUT 04)

·c: Function number (0: General, 1: Peak hold, 2: Valley hold, 3: P to P hold, 4: Sample

hold)

Error code ·Err-62: “c” out of range.
·Err-64: The specified OUT number exceeds the valid OUT range.

 Trigger Mode

Incoming command SW,OE,M,aa,c\r\n

Response

commands
SW,OE\r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT 01, 02: OUT 02... 04: OUT 04)

·c: Function number (0: Trigger 1, 1: Trigger 2).
Error code ·Err-62: “c” out of range.

·Err-64: The specified OUT number exceeds the valid OUT range.

 Filter

Incoming command SW,OC,aa,c,c\r\n

Response

commands
SW,OC\r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT 01, 02: OUT 02... 04: OUT 04)

·c: Function number

The first c: Filter mode (0: Average)

The second c: The function number of the filter mode selected by the first c

(0: Take the average once, 1: Take the average four times,

2: Take the average 16 times, 3: Take the average 64 times,

4: Take the average 256 times, 5: Take the average 1024 times,

6: Take the average 4096 times, 7: Take the average 16384 times,

8: Take the average 65536 times, 9: Take the average 262144 times)

Error code ·Err-62: “c” out of range.
·Err-64: The specified OUT number exceeds the valid OUT range.
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 Tolerance Settings

Incoming command SW,LM,aa,fffffff,fffffff,fffffff\r\n

Response

commands
SW,LM\r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT 01, 02: OUT 02... 04: OUT 04)

·fffffff: Set value format (valid digits: 6).

Values should be specified in the order of upper limit, lower limit, and delay. The first

bit of delay is not the sign bit but 0.
Error code ·Err-64: The specified OUT number exceeds the valid OUT range.

 Zoom

Incoming command SW,OB,aa,fffffff,fffffff,fffffff,fffffff\r\n

Response

commands
SW,OB\r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT 01, 02: OUT 02... 04: OUT 04)

·fffffff: Set value format (valid digits: 6). The values should be specified in order of the

measured value (input value) of point 1, the displayed value of point 1, the measured

value (input value) of point 2, and the displayed value of point 2.
Error code ·Err-64: The specified OUT number exceeds the valid OUT range.

·Err-68: “fffffff” does not meet the specifications in the set list.

 Offset

Incoming command SW,OF,aa,fffffff\r\n

Response

commands
SW,OF\r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT 01, 02: OUT 02... 04: OUT 04)

·fffffff: Set value format (valid digits: 6).

Error code ·Err-62: “fffffff” out of range.
·Err-64: The specified OUT number exceeds the valid OUT range.

 Minimum Display Unit

Incoming command SW,OG,aa,c\r\n

Response

commands
SW,OG\r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT 01, 02: OUT 02... 04: OUT 04)

·c: Function number (0: 0.01mm, 1: 0.001mm, 2: 0.0001mm, 3: 0.00001mm,

4: 0.1μm, 5: 0.01μm, 6: 0.001μm)
Error code ·Err-62: “c” out of range.

·Err-64: The specified OUT number exceeds the valid OUT range.
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 Analog output type switching

Incoming command SW,VK,aa,yy\r\n

Response

commands
SW,VK\r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT 01, 02: OUT 02... 04: OUT 04)

·yy: Function number (0: Analog output OFF, 1: Voltage output, 2: Current output)
Error code ·Err-64: The specified OUT number exceeds the valid OUT range.

 Upper and lower limits of analog measured values

Incoming command SW,VJ,aa,fffffff,fffffff\r\n

Response

commands
SW,VJ\r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT 01, 02: OUT 02... 04: OUT 04)

·fffffff: Set value format (valid digits: 6). The values should be specified in the order of

the upper and lower limits of the measured values.

Error code ·Err-64: The specified OUT number exceeds the valid OUT range.
·Err-68: “fffffff” does not meet the specifications in the set list.

 Upper and lower limits of Analog output

Incoming command SW,VI,aa,cccccc,cccccc\r\n

Response

commands
SW,VI\r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT 01, 02: OUT 02... 04: OUT 04)

·cccccc: Set value format (valid digits: 6). The values should be specified in the order

of the lower limit of the analog value and the upper limit of the analog output. When

setting the voltage, the unit of this value is 1mV; When setting the current, the unit
Error code ·Err-64: The specified OUT number exceeds the valid OUT range.

·Err-68: “cccccc” does not meet the specifications in the set list.
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5.5.3 Public Settings

 Sampling Frequency (SG5000 series)

Incoming command SW,CA,c\r\n

Response

commands
SW,CA\r\n

Parameter

Description

c: Function number (0: 590kHz, 1: 400kHz, 2: 200kHz, 3: 88kHz, 4: 50kHz, 5: 20kHz,

6: 10kHz, 7: 5kHz, 8: 2kHz, 9:1kHz)
Error code Err-62: “c” out of range.

 Sampling Frequency (SG3000 series)

Incoming command SW,CA,c\r\n

Response

commands
SW,CA\r\n

Parameter

Description

c: Function number (0: 88kHz, 1: 50kHz, 2: 20kHz, 3: 10kHz, 4: 5kHz, 5: 2kHz,

6:1kHz)
Error code Err-62: “c” out of range.

 Gating Time

Incoming command SW,CE,c\r\n

Response

commands
SW,CE\r\n

Parameter

Description
c: Function number (0: 2ms, 1: 5ms, 2: 10ms, 3: 20ms)

Error code Err-62: “c” out of range.

 Synchronous Settings

Incoming command SW,OJ,aa,c\r\n

Response

commands
SW,OJ\r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT 01, 02: OUT 02... 04: OUT 04)

·c: Function number (0: OFF, 1: ON)
Error code Err-62: “c” out of range.

Err-64: The specified OUT number exceeds the valid OUT range.

 Prevent mutual interference

Incoming command SW,CB,c\r\n

Response SW,CB\r\n
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commands

Parameter

Description
c: Function number (0: OFF, 1: AB-ON, 2: ABC-ON)

Error code Err-62: “c” out of range.
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 Prevent Mutual Interference Groups

Incoming command SW,HJ,qq,c\r\n

Response

commands
SW,HJ\r\n

Parameter

Description

·qq: Sensing head number (value 01 to 04).

·c: Function number (0: A, 1: B, 2: C).
Error code Err-62: “c” out of range.

Err-64: The specified sensing head number exceeds the active sensing head count.

 Data Storage

Incoming command SW,CF,ddddddd,ll\r\n

Response

commands
SW,CF\r\n

Parameter

Description

·ddddddd: Number of data to be stored (0000000 to 1200000)

·ll: Storage cycle (00:1x, 01:2x, 02:5x, 03:10x, 04:20x, 05:50x, 06:100x, 07:200x,

08:500x, 09:1000x, 10: Synchronous input)

Error code Err-62: "ddddddd" or "ll" is out of range.

 Specify OUT for Data Storage

Incoming command SW,OK,aa,c\r\n

Response

commands
SW,OK\r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT01, 02: OUT02... 04: OUT04)

·c: Function number (0: OFF, 1: ON)

Error code Err-62: “c” out of range.
Err-64: The specified OUT number exceeds the valid OUT range.

5.5.4 Network Settings

 IPAddress

Incoming command SW,EH,I,zzzzzzzzzzzz\r\n

Response

commands
SW,EH\r\n

Parameter

Description

zzzzzzzzzzz: IP address (Expressed as zzz. zzz. zzz. zzz)

Example: When the IP address is 10.10.1.9, specify “010010001009”.
Error code Err-62: “zzzzzzzzzzzz” out of range.

 Subnet Mask
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Incoming command SW,EH,M,zzzzzzzzzzzz\r\n

Response

commands
SW,EH\r\n

Parameter

Description

zzzzzzzzzzzz: Subnet mask (Expressed as zzz. zzz. zzz. zzz)

Example: When the subnet mask is 255.255.0.0, specify “255255000000”.

Error code Err-62: “zzzzzzzzzzzz” out of range.

 Default Gateway

Incoming command SW,EH,G,zzzzzzzzzzzz\r\n

Response

commands
SW,EH\r\n

Parameter

Description

zzzzzzzzzzzz: The IP address of the default gateway (Expressed as zzz. zzz. zzz. zzz)

Example: When the IP address is 10.10.1.9, specify “010010001009”
Error code Err-62: “zzzzzzzzzzzz” out of range.

5.5.5 Encoder Settings

 Operating Mode and Detection Direction

Incoming command SW,CJ,c,c\r\n

Response

commands
SW,CJ\r\n

Parameter

Description

The first c: operating mode (0: OFF, 1: timed, 2: triggered)

The second c: detection direction (0: positive & negative timing, 1: positive timing, 2:

negative timing)

Error code Err-62: “c” out of range.

 Input mode, minimum input time, and interval

Incoming command SW,CI,c,dddddddddd,dddddd\r\n

Response

commands
SW,CI\r\n

Parameter

Description

·c: Input mode (0:1 phase 1 increment (no direction), 1:2 phase 1 increment, 2:2 phase

2 increment, 3:2 phase 4 increment)

·dddddddddd: Minimum input time (unit: ns)

(0000000100/0000000200/0000000500/0000001000/0000002000/

0000005000/0000010000/0000020000)

·dddddd: Trigger interval (000001 to 010000)
Error code Err-62: “c”, “dddddddddd”, “dddddd” out of range.
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5.6 Settings for Obtained Commands

This section describes the format of the command used to obtain the set value.

Note: These commands are only accepted when the controller is in communication mode.

 The set value format containing decimal points will be returned.
 For detailed information on each command, please refer to "Setting Change Command" (Page 76).

5.6.1 Sensing Head Settings

 Detection Mode

Incoming command SR,HB,M,qq\r\n

Response

commands
SR,HB,M,qq,c\r\n

Parameter

Description

·qq: Sensing head number (value 01 to 04).

·c: Function number (0: General, 1: Semi-transparent object, 2: Transparent object, 3:

Transparent object, 2: Reflective resin).

Error code ·Err-64: The specified sensing head number exceeds the active sensing head count.

 Datum point

Incoming command SR,HB,B,qq\r\n

Response

commands
SR,HB,B,qq,c\r\n

Parameter

Description

·qq: Sensing head number (value 01 to 04).

·c: Function number (0: NEAR, 1: FAR).

Error code ·Err-64: The specified sensing head number exceeds the active sensing head count.

 ABLE

Incoming command SR,HA,M,qq\r\n

Response

commands
SR,HA,M,qq,m\r\n

Parameter

Description

·qq: Sensing head number (value 01 to 04).

·m: Mode (0: AUTO, 1: MANUAL).

Error code ·Err-64: The specified sensing head number exceeds the active sensing head count.

 ABLE Control Range

Incoming command SR,HA,R,qq\r\n
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Response

commands
SR,HA,R,qq,xx,xx\r\n

Parameter

Description

·qq: Sensing head number (value 01 to 04).

·xx: Control range data (01 to 99). Return values in order of upper and lower limits.

Error code ·Err-64: The specified sensing head number exceeds the active sensing head count.

 Reflective selection mode (installation mode)

Incoming command SR,HE,qq\r\n

Response

commands
SR,HE,qq,c\r\n

Parameter

Description

·qq: Sensing head number (value 01 to 04).

·c: Function number (0: Diffuse reflection, 1: Specular reflection).

Error code ·Err-64: The specified sensing head number exceeds the active sensing head count.

 Median

Incoming command SR,HG,qq\r\n

Response

commands
SR,HG,qq,c\r\n

Parameter

Description

·qq: Sensing head number (value 01 to 04).

·c: Function number (0：OFF, 1：7, 2：15, 3：31).

Error code ·Err-64: The specified sensing head number exceeds the active sensing head count.

 LASER CTRLGROUP

Incoming command SR,HH,qq\r\n

Response

commands
SR,HH,qq,c\r\n

Parameter

Description

·qq: Sensing head number (value 01 to 04).

·c: Function number (0: LASER CTRL1, 1: LASER CTRL2).

Error code ·Err-64: The specified sensing head number exceeds the active sensing head count.

 Shielding settings

Incoming command SR,HF,qq,c\r\n

Response

commands
SR,HF,qq,c,ffffffff,ffffffff\r\n

Parameter

Description

·qq: Sensing head number (value 01 to 04).

·c: Function number (0: OFF, 1: ON).

·ffffffff: Set value format (valid digits: 6). Return values in the order of point 1 and point 2.
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Error code ·Err-62: “c” out of range.

·Err-64: The specified sensing head number exceeds the active sensing head count.

 Alarm Handling

Incoming command SR,HC,N,qq\r\n

Response

commands
SR,HC,N,qq,nnnn,nnnn\r\n

Parameter

Description

·qq: Sensing head number (value 01 to 04).

·nnnn: Unsigned numerical value (0000 to 9999). Return values in the order of

counting and restoring counting.

Error code ·Err-64: The specified sensing head number exceeds the active sensing head count.

 Alarm Level

Incoming command SR,HC,L,qq\r\n

Response

commands
SR,HC,L,qq,c\r\n

Parameter

Description

·qq: Sensing head number (value 01 to 04).

·c: Function number (0 to 9)

Error code ·Err-64: The specified sensing head number exceeds the active sensing head count.

5.6.2 OUT Settings

 Calculation Method

Incoming command SR,OA,H,aa\r\n

Response

commands
SR,OA,H,aa,ggg\r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT01, 02: OUT02... 04: OUT04).

·ggg: Sensing head number (H01 to H04) or OUT number (O01 to O04), calculation

method (C01: ADD, C02: SUB, C03: AVE, C04: MAX, C05: MIN, C06: P-P).

Error code ·Err-64: The specified OUT number exceeds the valid OUT range.

 Measured Target

Incoming command SR,OA,T,aa\r\n

Response

commands
SR,OA,T,aa,c\r\n
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Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT01, 02: OUT02... 04: OUT04).

·c: Function number (0:1, 1:2, 2:3, 3:4, 4:1-2, 5:1-3, 6:1-4, 7:2-3, 8:2-4, 9:3-4).

Error code ·Err-64: The specified OUT number exceeds the valid OUT range.

 Calculation between OUTs (ADD, SUB)

Incoming command SR,OA,C,aa\r\n

Response

commands
SR,OA,C,aa,jj,jj\r\n

Parameter

Description

·Even if the calculation method is changed, the specified value will be retained.

·aa: OUT number (value 01 to 04, 01: OUT01, 02: OUT02... 04: OUT04).

·jj: OUT to be calculated (value 01 to 04).

For example, when the calculation formula is "OUT01+OUT02", these two "jj" values

will be "01" and "02".

Error code ·Err-64: The specified OUT number exceeds the valid OUT range.

 OUT to be Calculated (AVE/P-P/MAX/MIN)

Incoming command SR,OA,M,aa\r\n

Response

commands
SR,OA,M,aa,iiii\r\n

Parameter

Description

·Even if the calculation method is changed, the specified value will be retained.

·aa: OUT number (value 01 to 04, 01: OUT01, 02: OUT02... 04: OUT04).

·iiii: Used to specify the format of multiple OUT or HEAD.

Error code ·Err-64: The specified OUT number exceeds the valid OUT range.

 Detection Mode (measurement mode)

Incoming command SR,OD,aa\r\n

Response

commands
SR,OD,aa,c\r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT01, 02: OUT02... 04: OUT04).

·c: Function number (0: General, 1: Peak hold, 2: Valley hold, 3: P to P hold, 4: Sample

hold).

Error code ·Err-64: The specified OUT number exceeds the valid OUT range.

 Trigger Mode

Incoming command SR,OE,M,aa\r\n

Response

commands
SR,OE,M,aa,c\r\n
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Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT 01, 02: OUT 02... 04: OUT 04)

·c: Function number (0: Trigger 1, 1: Trigger 2)

Error code ·Err-64: The specified OUT number exceeds the valid OUT range.

 Filter

Incoming command SR,OC,aa\r\n

Response

commands
SR,OC,aa,c,c\r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT01, 02: OUT02... 04: OUT04).

·c: Function number

The first c: Filter mode (0: Average)

The second c: The function number of the filter mode selected by the first c

(0: Take the average once, 1: Take the average four times,

2: Take the average 16 times, 3: Take the average 64 times,

4: Take the average 256 times, 5: Take the average 1024 times,

6: Take the average 4096 times, 7: Take the average 16384 times,

8: Take the average 65536 times, 9: Take the average 262144 times)

Error code ·Err-64: The specified OUT number exceeds the valid OUT range.

 Tolerance Settings

Incoming command SR,LM,aa\r\n

Response

commands
SR,LM,aa,ffffffff,ffffffff,ffffffff\r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT01, 02: OUT02... 04: OUT04).

·ffffffff: Set value format (valid digits: 6). Return values in order of upper limit, lower

limit, and delay.

Error code ·Err-64: The specified OUT number exceeds the valid OUT range.

 Zoom

Incoming command SR,OB,aa\r\n

Response

commands
SR,OB,aa,ffffffff,ffffffff,ffffffff,ffffffff\r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT01, 02: OUT02... 04: OUT04).

·ffffffff: Set value format (valid digits: 6). Return values in the order of the measured

value (input value) of point 1, the displayed value of point 1, the measured value

(input value) of point 2, and the displayed value of point 2.
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Error code ·Err-64: The specified OUT number exceeds the valid OUT range.

 Offset

Incoming command SR,OF,aa\r\n

Response

commands
SR,OF,aa,ffffffff\r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT01, 02: OUT02... 04: OUT04).

·ffffffff: Set value format (valid digits: 6).

Error code ·Err-64: The specified OUT number exceeds the valid OUT range.

 Minimum Display Unit

Incoming command SR,OG,aa\r\n

Response

commands
SR,OG,aa,c\r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT01, 02: OUT02... 04: OUT04).

·c: Function number

When selecting the measured type as “displacement”

(0: 0.01mm, 1: 0.001mm, 2: 0.0001mm, 3: 0.00001mm, 4: 0.1μm,

5: 0.01μm, 6: 0.001μm)

Error code ·Err-64: The specified OUT number exceeds the valid OUT range.

 Analog output type switching

Incoming command SR,VK,aa\r\n

Response

commands
SR,VK,aa,yy \r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT 01, 02: OUT 02... 04: OUT 04)

·yy: Function number (0: Analog output OFF, 1: Voltage output, 2: Current output)

Error code ·Err-64: The specified OUT number exceeds the valid OUT range.

 Upper and lower limits of analog measured values

Incoming command SR,VJ,aa\r\n

Response

commands
SR,VJ,aa,ffffffff,ffffffff\r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT 01, 02: OUT 02... 04: OUT 04)

·ffffffff: Set value format (valid digits: 6). Return in the order of lower and upper

measured values.

Error code ·Err-64: The specified OUT number exceeds the valid OUT range.
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 Upper and lower limits of Analog output

Incoming command SW,VI,aa\r\n

Response

commands
SW,VI,aa,cccccc,cccccc \r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT 01, 02: OUT 02... 04: OUT 04)

·cccccc: Set value format (valid digits: 6). Range in the order of lower limit and upper

limit of analog output. When it is voltage, the unit of this value is 1mV; When it is

current, the unit of this value is 1 μA.

Error code ·Err-64: The specified OUT number exceeds the valid OUT range.
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5.6.3 Public Settings

 Sampling frequency (SG5000 series)

Incoming command SR,CA\r\n

Response

commands
SR,CA,c\r\n

Parameter

Description

c: Function number (0: 590kHz, 1: 400kHz, 2: 200kHz, 3: 88kHz, 4: 50kHz, 5: 20kHz,

6: 10kHz, 7: 5kHz, 8: 1kHz)
Error code -

 Sampling frequency (SG3000 series)

Incoming command SR,CA\r\n

Response

commands
SR,CA,c\r\n

Parameter

Description

c: Function number (0: 88kHz, 1: 50kHz, 2: 20kHz, 3: 10kHz, 4: 5kHz, 5: 2kHz,

6:1kHz)
Error code -

 Gating time

Incoming command SR,CE\r\n

Response

commands
SR,CE,c\r\n

Parameter

Description
C: Function number (0:2ms, 1:5ms, 2:10ms, 3:20ms)

Error code -

 Synchronous settings

Incoming command SR,OJ,aa\r\n

Response

commands
SR,OJ,aa,c\r\n

Parameter

Description

·aa: OUT number (value 01 to 04, 01: OUT01, 02: OUT02... 04: OUT04).

·c: Function number (0: OFF, 1: ON）。

Error code Err-64: The specified OUT number exceeds the valid OUT range.

 Prevent mutual interference

Incoming command SR,CB\r\n

Response

commands
SR,CB,c\r\n
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Parameter

Description
c：Function number (0:OFF, 1:AB-ON, 2:ABC-ON）。

Error code -
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 Prevent Mutual Interference Groups

Incoming command SR,HJ,qq\r\n

Response

commands
SR,HJ,qq,c\r\n

Parameter

Description

·qq: Sensing head number (value 01 to 04)

·c: Function number (0:A, 1:B, 2:C）

Error code Err-64: The specified sensing head number exceeds the active sensing
head count.

 Data storage

Incoming command SR, CF\r\n

Response

commands
SR,CF,ddddddd,ll\r\n

Parameter

Description

·ddddddd: Number of data to be stored (0000000 to 1200000).

·ll: Storage cycle (0:1x, 1:2x, 2:5x, 3:10x, 4:20x, 5:50x, 6:100x,

7:200x, 8:500x, 9:1000x, 10: Synchronous input).

Error code -

 Specify OUT for Data Storage

Incoming command SR,OK,aa\r\n

Response

commands
SR,OK,aa,c\r\n

Parameter

Description

·aa: OUT number (Values 01 to 04, 01: OUT01, 02: OUT02…04: OUT04).

·c: Function number (0: OFF, 1: ON).

Error code Err-64: The specified OUT number exceeds the valid OUT range.

5.6.4 Network Settings

 IPAddress

Incoming command SR,EH,I \r\n

Response

commands
SR,EH,I,zzzzzzzzzzzz \r\n

Parameter

Description

Zzzzzzzzzzzz: IP address (Expressed As zzz.zzz.zzz.zzz)

Example: When the IP address is 10.10.1.9, specify "010010001009".
Error code -

 Subnet Mask

Incoming command SR,EH,M\r\n
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Response

commands
SR,EH,M,zzzzzzzzzzzz\r\n

Parameter

Description

Zzzzzzzzzzzz: subnet mask (Expressed As zzz.zzz.zzz.zzz)

Example: When the subnet mask is 255.255.0.0, specify "255255000000".
Error code -

 Default gateway

Incoming command SR,EH,G \r\n

Response

commands
SR,EH,G,zzzzzzzzzzzz \r\n

Parameter

Description

Zzzzzzzzzzzz: The IP address of the default gateway (Expressed As zzz.zzz.zzz.zzz)

Example: When the IP address is 10.10.1.9, specify "010010001009".
Error code -

5.6.5 Encoder Settings

 Operation mode and detection direction

Incoming command SR,CJ\r\n

Response

commands
SR,CJ,c,c\r\n

Parameter

Description

The first c: operating mode (0: OFF, 1: timed, 2: triggered)

The second c: detection direction (0: positive & negative timing, 1: positive timing, 2:

negative timing)
Error code -

 Input mode, minimum input time, and interval

Incoming command SR,CI\r\n

Response

commands
SR,CI,c,dddddddddd,dddddd\r\n

Parameter

Description

·c：Input mode (0:1 phase 1 increment (no orientation), 1: 2 phase 1 increment, 2: 2

phase 2 increment, 3: 2 phase 4 increment)

·dddddddddd：Minimum input time (unit: ns)

（0000000100/0000000200/0000000500/0000001000/0000002000/

0000005000/0000010000/0000020000）

·dddddd：Trigger interval (00000 1 to 10000)
Error code -
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6 Appendix

6.1 Error Codes

Error Codes Description Remark
Err-50 Command error The received command is not a command defined by this system.

Err-51 Status error
Unable to perform operation (e.g. received command does not
match current communication mode).

Err-60 Command length error
The number of characters in the received command or parameter
is too long or too short.

Err-61
Insufficient number of
arguments

The number of parameters for the received command is
insufficient.

Err-62 Argument out of range The received setting value exceeds the allowed setting range.

Err-63
Argument out of range
(OUT reference limit)

The number of times a certain OUT value is repeatedly
referenced in the OUT calculation exceeds the limit.

Err-64
Argument out of range
(OUT/Sensor head
number)

The specified sensing head/OUT number exceeds the valid
sensing head/OUT count.

Err-66
Argument out of range
(OUT specification)

The calculation range of the specified OUT includes either the
OUT itself or the target OUT has not been set for
AVE/P-P/MIN/MAX calculation.

Err-68
Argument out of range
(Zoom)

The specified scaling parameter does not meet the following
conditions:
 Input value 1 - Input value 2 ≠ 0
 (Display value 2 - Display value 1)/(Input value 2 - Input

value 1) | ≤ 2

Err-71
Argument out of range
(OUT specified for data
storage)

The OUT number corresponding to the stored data exceeds the
valid OUT count.
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